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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published February 2018. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Overview 

Deltek Touch Time & Expense for Vision is a time-tracking tool that allows you to view, enter, 
update, and submit timesheet data and expense reports as well as approve timesheets (if you are 
a Timesheet system administrator) from anywhere at any time using your touch screen device 
and synchronize that data to the Vision database. To use the application, the Touch Server 
component must be installed into your Vision infrastructure (on your existing Vision application 
server or a separate server). 

 

The official name of the application is Deltek Touch Time & Expense for Vision. This document 
only uses it at first mention. The succeeding instances of the application name display Touch 
Time & Expense. 

In addition, the application name in Apple App Store and Google Play displays Deltek Vision 
Time & Expense. 

This document provides instructions for the installation and configuration of the Touch Time & 
Expense. 
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Downloading Deltek Products using Deltek 
Software Manager 

You can use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes, 
and sub-releases. You can access DSM directly or through the Deltek Customer Care Connect 
site. 

When you access DSM directly, you will be prompted to log on before you can access the 
application. If you access DSM from within the Deltek Customer Care site, you do not have to log 
on since you are already logged into the Customer Care site. 

Accessing DSM Directly 

To access Deltek Software Manager directly, complete the following steps: 

1. Launch Deltek Software Manager by taking one of the following actions: 

 Click here.  

 On your desktop, click Start » All Programs » Deltek Software Manager. 

2. In the Deltek Software Manager logon dialog box, enter your Deltek Customer Care User 
ID and Password, and click Logon. 

3. To select the folder where you want to download Deltek products, click Settings above 
the right pane of Deltek Software Manager. 

 

When you log on for the first time, Deltek Software Manager asks you to select a 
default folder where Deltek products are to be downloaded.  

4. Use the Settings dialog box to specify the folder where you want to download Deltek 
products, and click OK.  

 

You can change this folder anytime in the Settings dialog box.  

5. In the left pane of Deltek Software Manager, expand the Deltek product that you want to 
download, if it is not already expanded.  

 

If you clicked the link in step 1 to access DSM, the application automatically selects 
Touch Time & Expense for Vision for you. 

6. Select the product type that you want to download. Your options are Complete, HotFix, 
and Sub-Release. 

7. In the table, select the check box that corresponds to the Deltek product that you want to 
download. The right pane displays a message stating that the product has been added to 
the download queue. 

 

To view the items in the download queue, click View Download Queue at the bottom 

of the left pane.  

https://dsm.deltek.com/DeltekSoftwareManager/DeltekSoftwareManager.application?ReleaseID=ABF103FE-AA82-4269-BE54-573A7848F251
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8. Click Download at the bottom of the left pane. Deltek Software Manager downloads the 
product to the folder that you selected.  

Accessing DSM from within the Customer Care Connect Site 

To access Deltek Software Manager from within the Customer Care Connect site, complete 
the following steps: 

1. In your Web browser, go to http://support.deltek.com.  

2. Enter your Customer Care Connect Username and Password, and click Log In. 

3. When the Customer Care Connect site displays, click the Product Downloads tab. 

You are automatically logged into Deltek Software Manager. 

4. To select the folder where you want to download Deltek products, click Settings above 
the right pane of Deltek Software Manager. 

 

When you log on for the first time, Deltek Software Manager asks you to select a 
default folder where Deltek products are to be downloaded.  

5. Use the Settings dialog box to specify the folder where you want to download Deltek 
products, and click OK.  

 

You can change this folder anytime in the Settings dialog box.  

6. In the left pane of Deltek Software Manager, expand the Deltek product that you want to 
download, if it is not already expanded.  

7. Select the product type that you want to download. Your options are Complete, HotFix, 
and Sub-Release. 

8. In the table, select the check box that corresponds to the Deltek product that you want to 
download. The right pane displays a message stating that the product has been added to 
the download queue. 

 

To view the items in the download queue, click View Download Queue at the bottom 

of the left pane.  

9. Click Download at the bottom of the left pane. Deltek Software Manager downloads the 
product to the folder that you selected.  

DSM Documentation and Troubleshooting 

 To view the online help for Deltek Software Manager, click here. 

 To view a tutorial on how to use Deltek Software Manager, click here.  

 To view more information on troubleshooting Deltek Software Manager, click here. 

 

The above troubleshooting link will only work if you are logged into Deltek Customer 
Care Connect. 

http://support.deltek.com/
https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://dsm.deltek.com/DeltekSoftwareManager/Tutorial/PubData/Engine/Default.htm?https%3A%2F%2Fdsm.deltek.com%2FDeltekSoftwareManager%2FTutorial%2FPubData%2F
https://deltek.custhelp.com/app/answers/detail/a_id/52469
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Prerequisites 

Before you install Touch Time & Expense, it is important to understand the following information: 

 Touch Time & Expense works with Vision 7.6 Cumulative Update #09. 

 

 To use the full functionality of Touch Time & Expense, you must be on the latest 
Touch Server and Vision. 

 When installing Touch Time & Expense on a dedicated server, ensure that the 
Vision Web service URL (for example, 
https://server.company.com/vision/visionservices.asmx) can be accessed from the 
Touch Server. This includes ensuring that the required TCP/IP ports (for example, 
443) are open and the Vision server can be resolved via DNS from the Touch 
Server. 

 You must own Vision Core. 

 You must install Touch Time & Expense on an IIS server that is installed on Windows 
Server 2012, Windows Server 2012 R2, or Windows Server 2016. 

 Starting with 1.7, Touch Time & Expense requires that the Vision server be accessed 
using Secure Sockets Layer (SSL)/Transport Layer Security (TLS). Deltek 
recommends that you update your configuration to support this change to avoid 
issues with future releases should your system not already be configured this way. 

 

 When Vision is not exposed to the Internet, a VPN can be used to connect the 
mobile device to the corporate network on which Vision resides to provide the 
connection needed for Touch Time & Expense. However, while the most common 
VPN configurations will most likely work without problems, Deltek has not tested all 
possible VPN types and configurations to ensure compatibility. 

 Touch Time & Expense does not support two-factor authentication (2FA) and 
multifactor authentication (MFA). 

 When using SSL, you must have a certificate issued by a trusted certificate authority. 
You must not use self-signed certificates. Wild card certificates work if they come 
from a trusted certificate authority; however, they are not recommended as best 
practice. 

 Touch Time & Expense supports mobile applications downloaded from Apple App 
Store and Google Play. If you are using an unsupported version of your Vision core 
product (compatibility mode), you can use your device’s native browser to enter your 
organization’s Touch Time & Expense URL but with some limitations. 

 

 Starting with 1.7.7, Windows Phone is no longer supported. 

 The Touch Time & Expense URL has the format 
https://<server>/deltektouch/vision/time, where <server> refers to the host name of 
your Touch Server. 

 If you are on iOS 9.0 or lower, Touch Time & Expense would not be available from 
Apple App Store. In this case, you would not be able to download or update it. 

 In addition, Touch Server 1.3 and lower are already incompatible because the 
Chrome browser does not work with these versions any more due to a major 
change on Chrome. 

 Touch Time & Expense installer installs PHP 7.1.8 in this release. 

https://server.company.com/vision/visionservices.asmx


Prerequisites 

 

Technical Installation Guide 5 

 

 

Apple’s iOS blocks connections to servers with deprecated secure transport layers. 

Starting with iOS 9, Apple’s iOS mobile operating system started blocking deprecated transport layers. 
As of iOS version 10, iOS blocks connections to servers that have either TLS 1.0, SSL 3 (or lower) 
enabled or any older protocols. Only TLS 1.1 and/or TLS 1.2 may be enabled for connections to be 
successful. If you try to connect to IIS servers running Touch CRM, an error message displays, such as 
“invalid server URL” if any of the deprecated protocols are enabled. 

To resolve this issue, the following must be performed to Touch Server: 

 Deprecated transport layers disabled 

 Supported transport layers enabled (if not already) – TLS 1.1 and/or TLS 1.2 

 Restart the server 

For more information on how to disable the deprecated transport layers, see the following support article 
from Microsoft:  How to disable PCT 1.0, SSL 2.0, SSL 3.0, or TLS 1.0 in Internet Information Services at 

https://support.microsoft.com/en-us/kb/187498. 

Compatibility Mode Definitions 

Compatibility Mode Description 

Fully Compatible with 

Vision 

You must be on the latest version of each component (Touch Time 

& Expense application, Touch server, and API). All features and 

functions in the application are available to you. 

Partially Compatible with 

Vision 

 

You can use the Touch Time & Expense application in this 

environment but some features will be hidden until Touch Server 

and Vision core is updated. 

Potentially Compatible 

with Vision but no 

Longer Tested 

 

The Touch Time & Expense application may be compatible with 

Vision, but this combination is no longer tested or supported by 

Deltek. 

Incompatible You cannot use both the Touch Time & Expense (native 

application) and its browser version.. 

https://support.microsoft.com/en-us/kb/187498


Prerequisites 

 

Technical Installation Guide 6 

 

Touch Time & Expense 1.7.7 (Native Application) Version Compatibility 

 

 

For Touch Time & Expense 1.7.6 (or lower), see the Deltek Touch Time & Expense Technical 
Installation Guide of that release. 

Supported Mobile Operating Systems 

Touch Time & Expense supports mobile devices that run on the following operating systems: 

 Apple iOS 10.0 and higher 

 Android 4.4 and higher 
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Deltek Touch Infrastructure 

The Deltek Touch infrastructure is composed of the application tier, middle tier, and services tier. 
The Touch Server (middle tier) is used to optimize service delivery and transform data when 
necessary. The Touch Server only communicates with the product service layer and does not 
have access to the database. 

The Touch application (client tier) is a hybrid application created using HTML 5 and CSS 3 but 
with the ability to access the native device capabilities. 

 

This infrastructure applies to Deltek Touch Time & Expense for Vision, Deltek Touch CRM, 

Deltek Touch for GovWin CM, and Deltek Touch CRM for Ajera. 

Technical Platform 
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Supported Deployment Scenarios 

The Deltek Touch for Vision application may be installed on another IIS server or as a separate 
directory on an existing Vision IIS server. 
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Microsoft IIS Web Server Configuration on 
Windows 2012 Server 

Perform this procedure if you are going to install the Touch Time & Expense application on 
Windows Server 2012. The Touch Time & Expense installer checks if Microsoft Internet 
Information Services (IIS) is already installed before proceeding with the installation. The 
installation terminates if IIS is not yet installed. 

 

Touch Time & Expense requires Anonymous Authentication and does not support Basic 

Authentication. 

To configure Microsoft IIS web server on Windows 2012 Server, complete the following 
steps: 

1. From the desktop view, display the Charm Bar. To do this, take one of the following 
actions: 

 Move the cursor to the bottom right corner of the screen, which causes the bar to 
display on the right. 

 On your keyboard, press the Windows key + C. 

 

For more information about Charm Bar, see the following link: 
http://windows.about.com/od/windowsforbeginners/a/Get-To-Know-The-New-Windows-
8-Start-Menu.htm. 

2. Click Start » Administrative Tools » Server Manager. 

3. On the left pane, click IIS. 

4. On the right pane, scroll down to the see the ROLES and FEATURES section. 

5. From the Tasks drop-down list, select Add Roles and Features. The Add Roles and 
Feature Wizard displays. 

6. Click Next. 

7. Select the Role-based or feature-based installation option. 

8. On the Select destination server page, verify if the Select a server from the server 
pool option is selected. Click Next. 

9. On the Select server roles page, expand Web Server (IIS) » Web Server » 
Application Development, select CGI and ISAPI extensions 

10. On the Select server roles page, expand Web Server (IIS) » Web Server » 
Management Tools, and select IIS Management Scripts and Tools. 

11. On the Select server roles page, expand Web server (IIS) » Web Server » Management 
Tools » IIS 6 Management Compatibility » IIS 6 Metabase Compatibility. 

12. Click on Next. The Select features page displays. 

13. Click Next, and click Install.  

  

http://windows.about.com/od/windowsforbeginners/a/Get-To-Know-The-New-Windows-8-Start-Menu.htm
http://windows.about.com/od/windowsforbeginners/a/Get-To-Know-The-New-Windows-8-Start-Menu.htm
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Touch Time & Expense Installation 

Before you proceed, make sure that you downloaded the server component from Deltek Software 
Manager (DSM). Once the server part is installed, download the application from Google Play, 
Apple App Store, or Windows Store and install it in your device. 

 

For more information about DSM, see Downloading Deltek Products using Deltek Software 
Manager in this document. 

To install the Deltek Touch application, complete the following steps: 

1. Run DeltekTouchVisionTimeandExpense177.exe to launch the Touch Time & 
Expense installation program. 

 

Taking into consideration the enhanced security in Windows Server 2008, Deltek 
recommends selecting the Run as Administrator option when launching the 

installation executables even if you (as the logged-on user) has local administrative 
rights. You can access this option by right-clicking the installation executable file name 
in Windows Explorer, and clicking Run as Administrator on the shortcut menu. 

2. On the Welcome to the Deltek Touch Vision Time & Expense 1.7.7 Installation Wizard 
page, click Next. 

3. On the License Agreement page, review the license agreement, select the I accept the 
terms of the license agreement option, and click Next. 

4. On the Choose Application Install Directory page, verify if the default location for the 
Deltek Touch software is correct, and click Next. Otherwise, click Browse to navigate to 
the installation folder. 

 

The default folder is C:\Program Files (x86)\Deltek\Touch on a 64-bit machine and 
C:\Program Files\Deltek\Touch on a 32-bit machine. 

5. This step only applies if Vision is NOT installed in the same server as Touch Time & 
Expense. On the IIS Website Information page, select or enter the default Web site and 
virtual directory name, and click Next. Wait until the installer finishes validating PHP. 

6. On the Deltek Vision Web Services URL page, either enter the Web Services URL or 
accept the default value, and click Next. 

 

Your Vision server must end with VisionServices.asmx. 

When installing Touch Time & Expense on a dedicated server, ensure that the 
Vision Web service URL can be accessed from the Touch Server. 

7. On the Customer Experience Improvement Program page, select the Send Installation 
Data to Deltek option if you want to participate. 

8. On the Pre-Installation Summary page, review the installation details that you provided. 

 If you want to change any settings, click Back, and make the necessary updates.  

 If you are done, click Install to begin the installation.  

 

If there are errors, the DeltekTouchInstall.log file displays. 
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9. During the installation process, one of the following scenarios occur on the Setup Status 
page: 

 If you do not have Microsoft Visual C++ installed in your computer, the Microsoft 
Visual C++ Redistributable (x86) window displays, containing the Microsoft Software 
License Terms. Click I agree to the license terms and conditions and click Install. 
Wait until the Setup Successful message displays, and click Close. 

 If you have Microsoft Visual C++ installed in your computer, the Modify Setup 
message on the Microsoft Visual C++ Redistributable (x86) window displays. Click 
Close, and click Yes to confirm your action. 

 

The PHP upgrade, which contains the latest security fixes, requires the Microsoft Visual 
C++ Redistributable (x86) installation.  

10. When the installation is done, on the InstallShield Wizard Complete page, this page 
contains the URL of the database that you need to access in order to log into Touch Time 
& Expense on your mobile device. Send this URL to all the users who will be using Touch 
Time & Expense. Click Finish. 
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Appendix A: Touch Server URL in Email 

Logging on for the first time no longer requires users to enter the complete URL of the Touch 
Server. You now send them an email message containing a link that either directs them to the 
appropriate app store (if Touch Time & Expense is not yet installed) or populates the Touch 
Server URL field with their company URL. 

 

This feature only supports Touch Server 1.6.3 and higher. 

ProductApplication.php 

The Touch Server has been updated with the ProdcuctApplication.php file that performs the 
linking and passes the Touch Server URL value to the application or redirects you to the 
appropriate app store.  

Link for Customers 

The link that you send to users is a hyperlink. When users click the hyperlink, the following 
scenarios occur: 

1. If Deltek Touch is not installed, it takes them to the appropriate app store to download the 
application. 

a) Users then download the application from the app store. 

b) They click the link again (and proceed to step 2). 

2. If the application is installed, it populates the Touch Server URL field with their company 
URL. 

3. They tap the Connect button to connect to the Touch Server. 

How to Create the Link to Email Users 

Each application may have specific steps required to create a hyperlink. This section describes 
the steps that apply to Microsoft Outlook. For other applications, see the documentation on 
creating a hyperlink. 

1. Use the following format for the hyperlink: 

https://<yourdomain>/deltektouch/vision/time/visionshared/backend/visiontimeurl.
php 

2. Replace <yourdomain> with the company’s domain information. The domain must be 
externally accessible to devices on the Internet. The following part of the hyperlink, 
however, is fixed:  

deltektouch/vision/time/visionshared/backend/visiontimeurl.php 

3. Create the instructional text in the email message where you will embed the link. 

4. Highlight the word “here,” right-click, and select Hyperlink from the menu (alternatively, 
click the Insert tab, and click the Hyperlink button).  

5. Paste the hyperlink into the Address field of the dialog box, and click OK. 
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For Example: 

You have been given access to Deltek Touch Time & Expense. Click this link from your device 
to start using it: 

https://<yourdomain>/deltektouch/vision/time/visionshared/backend/visiontimeurl.php 

If you have not yet installed Touch Time & Expense, you will need to click the link twice: once to 
install the app and once after installation to populate your company's URL. If you have already 
been using Touch on your device, there is no need to click the link. 

If you cannot click the link, you can also copy and paste it into your browser on your device. 

When users receive the email, click the link, and the application is installed, the Server URL 
screen displays. 
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Appendix B: If You Need Assistance 

If you need assistance installing, implementing, or using Deltek Touch Time & Expense, Deltek 
makes a wealth of information and expertise readily available to you. 

Customer Services 

For over 30 years, Deltek has maintained close relationships with client firms, helping with their 
problems, listening to their needs, and getting to know their individual business environments. A 
full range of customer services has grown out of this close contact, including the following: 

 Extensive self-support options through the Customer Care Connect Web portal. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 

 

Find out more about these and other services from the Customer Care Connect site. 

Customer Care Connect Site 

The Deltek Customer Care Connect site is a support Web site for Deltek customers who 
purchase an Ongoing Support Plan (OSP).  

The following are some of the many options that the Customer Care Connect site provides: 

 Search for product documentation, such as release notes, install guides, technical 
information, online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers 
through the Deltek Connect Customer Forums 

 Access Cloud specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 

For more information regarding Deltek Customer Care Connect, refer to the online help available 
from the Web site. 
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Access Customer Care Connect 

To access the Customer Care Connect site, complete the following steps:  

1. Go to http://support.deltek.com. 

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 

 

If you do not have a username and password for the Customer Care Connect site, contact your 

firm’s Deltek Touch CRM Administrator. 

If you forget your username or password, you can click the Account Assistance button on the 

login screen for help. 

Additional Documentation 

The following table lists the additional Deltek documentation available for this release. Except 
where noted, all the user guides and quick reference guides listed in this table are available for 
download from the Deltek Customer Care Connect site. 

Document Name Description 

Deltek Touch Time & Expense for Vision User 
Guide 

This document contains detailed information 
and instructions on how to use various 
features of the application. 

Deltek Touch Time & Expense for Vision 
Release Notes 

This document contains a summary of the 
technical considerations, major features, and 
known issues of the application. 

 

 

 

 

http://support.deltek.com/


 

 

Deltek is the leading global provider of enterprise software and information solutions for professional 
services firms, government contractors, and government agencies. For decades, we have delivered 
actionable insight that empowers our customers to unlock their business potential. Over 14,000 
organizations and 1.8 million users in approximately 80 countries around the world rely on Deltek to 
research and identify opportunities, win new business, optimize resource, streamline operations, and deliver 
more profitable projects. Deltek – Know more. Do more.®  
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